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CHAPTER 8

ASSIGNING RESOURCES

INFOCUS
WPL_J407

Once you have entered tasks and resources into a project you can use the
resources and assign them to the tasks. There are a number of benefits to
assigning resources, particularly clarifying responsibility, knowing how long it will
take to complete a task and knowing how much the task will cost.
Microsoft Project allows you to enter resources in a number of ways and using a
number of techniques. For example, you can assign resources through a form
view, a sheet view and even through a dialog box. The technique you use is
determined largely by your own personal preferences.
More than one resource can be assigned for any given task. However, as you
will see, care needs to be exercised to ensure that you assign resources at the
appropriate time and in the correct way, otherwise scheduling problems may
ensue.
You can also assign resources on a part-time basis, perhaps to share the same
resource across more than one task. Microsoft Project is also flexible enough to
allow you to contour resource assignments.

In this session you will:
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learn how to create simple assignments using a split view
learn how to assign part time resources
gain an understanding of contouring resource usage
learn how to specify resource usage
learn how to apply a default contour
learn how to modify usage hours along an existing
contour
learn how to enter work times for several resources
learn how to resolve resourcing problems
learn how to assign resources using Task Information
learn how to assign resources in a sheet
learn how to assign resources that aren't in the pool
gain an understanding of assigning resources in a wider
range of tasks.
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SIMPLE RESOURCE ASSIGNMENTS
Split views where a Gantt Chart is displayed in
the top pane and a task form in the lower pane
are perfect for making resource assignments.
The lower pane allows you to display the

resources used in a task. With this view you can
see the immediate effect on a Gantt bar of
assigning resources.

Open
File

Try This Yourself:










Before starting this exercise
you MUST open the file
J407 Assigning
Resources_1.mpp...
Click on the View tab on
the Ribbon and click on
Gantt Chart in Task Views
Click on Details in the Split
View group to display a
task form and drag the task
form up towards the top of
the screen

3

The Task Form (at the bottom of the split view) here
shows Units and Work. If your form is different to the one
shown here, click in the form, click on the Format tab on
the Ribbon and click on Resources & Predecessors.

Click on Create
architectural plans in the
Gantt Chart
Click on the Resource tab
on the Ribbon and click on
Assign Resources to see
the Assign Resources
dialog box
Click on Architect in the
dialog box and click on
[Assign] to assign one
architect

6

Click in Units for
Draftsperson in the dialog
box, type 200% and click
on [Assign]

One Architect working full-time for the 3 week duration
will work 112.5 hours (37.5 x 3). Two Draftspersons
working full-time for the 3 week duration will work 225
hours (37.5 x 3 x 200%)

Click on Create
architectural plans in the
Gantt Chart and click on
the Action Button
Click on Increase total
work…

For Your Reference…

Handy to Know…

To create simple resource assignments:
1. Display a split view with a Gantt Chart in the
top and a Task Form at the bottom
2. Display the Assign Resources dialog box
(Resource -> Assign Resources)
3. Assign the desired resources

 If you are happy with the result of the Work,
Duration and Units after you’ve made an
assignment you don’t have to click on the
Action Button to confirm what Project has
done.
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ASSIGNING PART TIME RESOURCES
Not all resources will be required to work full-time
on a task. Quite often you will need to assign a
resource on a part-time basis. Assigning
part-time involvement is done by specifying a

3

Same File

Try This Yourself:








percentage less than 100% in Units. For example
in the Create architectural plans task we need
some part time work done by the clerk.

Continue using the
previous file with this
exercise, or open the file
J407 Assigning
Resources_2.mpp...
Ensure that the Create
architectural plans task
is still selected in the
Gantt Chart
Click on Units for
Building Clerk in the
Assign Resources dialog
box
Type 25% and click on
[Assign]
Click on Create
architectural plans in the
Gantt Chart and click on
the Action Button
Click on Increase total
work…
Click on [Close] to close
the Assign Resources
dialog box

4
The question really being asked here by Microsoft Project is do
you want to make the calculation based on effort? For example,
if you opt to reduce the duration Microsoft Project will perform
an effort-based calculation as follows:
New Duration = (Existing hours / new number of resources) x
Existing Duration
Thus the new duration would be calculated at 103.85 hours or
2.77 weeks, i.e. (112.5 / 3.25) x 3

For Your Reference…

Handy to Know…

To assign part-time resources:
1. Click on Units for the resource in the Assign
Resources dialog box
2. Type a percentage that represents the part
time component (e.g. 25%) and click on
[Assign]

 The advantage of clicking on the Action
button, even if you just accept the default, is
that it clears the triangle away.
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UNDERSTANDING WORK CONTOURING
Each resource has a resource work pattern
which is defined as the division of work by a
resource over the duration of the task. Microsoft
Project allows you to shape the work amounts by

adjusting the hours which have been assigned. You
can apply work amounts by manually adjusting the
hours or by applying one of the built-in contours.

The Resource Work Pattern
Microsoft Project normally assigns a flat work pattern for resources over the duration of a task. This
simply means that an equal number of hours per day are assigned over the duration of a task.
If a plumber had to work for 20 hours over 5 days on a task Microsoft Project would calculate the
resource work pattern as shown in the table.
Resource

Units

M

T

W

T

F

Total

Plumber

50%

4h

4h

4h

4h

4h

20h

Microsoft Project allows you to assign a contour type to the task that the resource is working on.
Microsoft Project will then calculate the hours to assign daily based on the contour type. The contour
types are shown in the following table.
Icon

Contour Type

Description

Back Loaded

More hours toward end of task

Front Loaded

More hours toward front of task

Double Peak

Two peaks in the middle of the task

Early Peak

An early peak in the task

Late Peak

A late peak in the task

Bell

More hours toward the centre of the task

Turtle

A plateau of more hours toward the centre of the task

The table below shows an example of the resource work pattern with a front loaded contour type
assigned.
Resource

Units

M

T

W

T

F

M

T

W

T

F

Total

Plumber

50%

4h

4h

3h

3h

2h

1h

1h

1h

1h

0h

20h

The really nice feature with contouring is that you can edit the hours entered by Microsoft Project
and apportion them exactly as you need.
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SPECIFYING RESOURCE USAGE
In our case study, the architect is required to
submit plans for approval. While the task duration
is currently 1 month, the architect is only required
for 8 hours – 5 hours at the start to complete and

submit the plans, then 3 hours at the end to collect
the permits and approvals. We’ll use a front
loaded contour to see whether this will help us.

Same File

Try This Yourself:




Continue using the
previous file with this
exercise, or open the file
J407 Assigning
Resources_3.mpp...
Click on Submit plans for
approval, click on the Task
tab on the Ribbon and click
on Scroll to Task in the
Editing group

2

Click on the drop arrow
in the Task Form for Task
type and click on Fixed
Duration, then click on
[OK]
Since permit approvals are
largely out of our control
and we know that it will
take a month, we should fix
its duration...




Click in Resource Name,
then click on the drop arrow
and select Architect

4

Click in Work and type 8h,
then click on [OK]
The Architect has only to
complete some forms and
take them to Council at the
beginning of the task, then
pick up the permits and
approvals at the end of the
task

For Your Reference…

Handy to Know…

To specify resource usage:
1. Select the task
2. Fix the duration of the task
3. Enter an assignment and change the Work
to the total hours the resource will work

 It is important to fix the duration of most
tasks that you wish to contour. If you don’t,
the duration probably will be changed by
Microsoft Project to something totally
unexpected and weird.
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CONTOURING WORK HOURS
If you want to contour a task in very precise
measures you can by-pass automatic contouring
and insert work hours directly into the Task
Usage sheet. This can be done by editing the

3

Same File

Try This Yourself:






work amounts in the timesheet area or the Task
Usage or Resource Usage view.

Continue using the
previous file with this
exercise, or open the file
J407 Assigning
Resources_4.mpp...
Click on Submit plans
for approval, click on the
View tab on the Ribbon,
click on the drop arrow
for Details in Split View
and click on Task Usage
Scroll the task timeline
until you can see the work
for the task

4

Double click on Architect
in the Task Form to
display the Assignment
Information dialog box
Click on the drop arrow
for Work contour and
select Front Loaded,
then click on [OK]
Project will now attempt to
load more work hours at
the beginning of the task.
A Front Loaded icon will
appear next to the
resource name in the
Task Usage view...



Click on the right scroll
arrow of the timeline and
notice how the hours do
eventually diminish

5

The problem here is that Front Loading doesn't really reflect the
way we want the hours to be. The Architect will spend 5 hours
on the first day submitting the plans, then 3 hours on the last
day collecting permits. We will therefore edit the values and
adjust them to what we need.

For Your Reference…

Handy to Know…

To apply a default contour:
1. Double click on a resource to display the
Assignment Information dialog box
2. Click on the drop arrow
for Work contour
and select the desired contour
3. Click on [OK]

 As part of the contouring algorithm used in
Microsoft Project the work hours will be
recalculated so that the contouring can be
accommodated – notice that our work hours
have dropped from 8 hours to 4.8 hours!
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ASSIGNING SPECIFIC WORK TIMES
To take proper control of contouring you should
enter your own times into the Task Usage sheet.
Even though choosing a default contour from one
of Microsoft Project’s options it has done some

pretty bizarre things with the hours. Using the
contour shape as a guide we’ll now insert hours as
we feel they should be carried out.

Same File

Try This Yourself:






Continue using
the previous file
with this exercise,
or open the file
J407 Assigning
Resources_5.mpp
Ensure that
Submit plans for
approval is
selected in the top
pane, click on
0.4h for Monday,
June 1, type 5h
and press
to
jump to the next
entry
Repeat step 1
and change all of
the dates from
Tuesday, June 2,
to Thursday
June 25 to 0

1

2

Ensure that you
are currently at
0.03h for Friday,
26 June, type 3h
and press

3

For Your Reference…

Handy to Know…

To change specific usage hours:
1. Display the Work Usage timeline
2. Type the desired hours into the relevant
dates to achieve the work usage you need

 Watch how the Work hours change as you
modify the usage hours. You should ensure
when you have finished that the adjusted
usage hours total to the Work that you
require to be done.
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WORK TIMES FOR MULTIPLE ASSIGNMENTS
Sometimes one resource on a task needs to work
at the start and another towards the end. In our
case study the task of Ordering materials falls
upon both the draftsperson and the building clerk.

The draftsperson is required to create the original
quantity specifications and the clerk is required to
raise the orders based on these specifications.

Same File

Try This Yourself:








Continue using the
previous file with this
exercise, or open the file
J407 Assigning
Resources_6.mpp...
Click on Order
materials in the Gantt
Chart, click on the View
tab on the Ribbon, click
on the drop arrow
for
Details in Split View
and click on Task Form
Click on the drop arrow
for Task type, click
on Fixed Duration and
click on [OK]

3

5

Click in Resource
Name and enter a
Draftsperson for
48.75h of Work and a
Building Clerk for
18.75h Work – click on
[OK] when these have
been entered

Draftsperson

Clerk

Mon

29/6

7.5h

0h

Tues

30/6

7.5h

0h

Wed

1/7

7.5h

0h

Thur

2/7

7.5h

0h

Fri

3/7

7.5h

0h

Mon

6/7

7.5h

3.75h

Tues

7/7

3.75h

7.5h

Wed

8/7

0h

7.5h

Click on the View tab,
click on the drop arrow
for Details and click
on Task Usage to see
the usage again
Enter the hours for the
two resources as shown

For Your Reference…

Handy to Know…

To enter work times for several resources:
1. Fix the duration of the task and enter the
Work hours for relevant resources
2. Change the view to Task Usage and enter
the work hours on the timeline

 A material resource can also have its work
amounts manually contoured. This will give a
better indication of the distribution of the
quantity of materials over the duration of the
task.
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PROBLEM ASSIGNMENTS
Unfortunately life with Microsoft Project is not
always easy – take your eye off the detail and
you'll be amazed at what slips by! The fencing
contractor in our case study uses labour who are

members of the GBWU – this union has negotiated
that they don't work on Fridays. So, what happens
when we assign this resource to a task, which falls
on a Friday?

Same
File

Try This Yourself:









Continue using the previous
file with this exercise, or
open the file J407 Assigning
Resources_7.mpp...
Click on the View tab on the
Ribbon, click on the drop
arrow
for Details, and
click on Task Form

The Gantt bar now stretches over 4 working days, whilst the
duration still shows 3. The contractor requires 3 days (3 x 7.5h =
22.5h) to complete the task. But since the contractor doesn’t
work on Fridays it will take an extra day to complete the task.

3

In the Gantt Chart scroll to
and click on Erect fencing
Click in Resource Name,
select No Barrier Fencing,
then click on [OK]

5

Double click on No Barrier
Fencing, click on the
General tab, and click on
[Change Working Time] to
see the Change Working
Time dialog box
Click in Name in
Exceptions, type Additional
work day and change the
Start and Finish days to 10
July 2015
Click on [Details] to see the
Details dialog box, click on
Working times and adjust
the hours as shown
Click on [OK] in both open
dialog boxes

6

The task will now finish on
Monday, 13 July

Here we’re effectively adjusting the resource calendar so that the
fencing contractor will work on a Friday – but only Friday July 10.

For Your Reference…

Handy to Know…

To change resource working time:
1. Double-click on the resource name, and
click on [Change Working Time]
2. Make the necessary changes to the
calendar and working time
3. Click on [OK]

 When a resource is created one of the preexisting calendars in the project is assigned
to it. The calendar belonging to the resource
takes on a life of its own and becomes what
is known as the resource calendar. Any
changes made here remain only with the
resource in which the change was made.
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ASSIGNING RESOURCES IN TASK INFORMATION
Project has an information dialog box for tasks
and resources. These boxes provide access to
the various fields for either the task or the
resource and present virtually a complete picture.

You can also use a Task Information dialog box
as a means of entering resource assignments.

Same File

Try This Yourself:









Continue using the
previous file with this
exercise, or open the file
J407 Assigning
Resources_8.mpp...
Double-click on Erect
site buildings to display
the Task Information
dialog box, then click on
the Resources tab
Click underneath
Resource Name and
click on the drop arrow
. Click on
Supervisor, then click
in the next line

2

Click on the drop arrow
, then click on
Carpenter
Click in Units and type
400%
Click on the line beneath
Carpenter and click on
the drop arrow , then
click on Labourer
Click in Units and type
800%
Click on [OK] to record
the assignments in the
project

6

For Your Reference…

Handy to Know…

To assign resources using Task Information:
1. Double-click on the task, then click on the
Resources tab
2. Select a resource from Resource Name
3. Type the appropriate amount of units
4. Click on [OK]

 The Assign Resources box is handy for
entering single resource assignments.
However, each time you click [Assign] all of
the scheduling is recalculated. With multiple
assignments it is better to use the Task
Information dialog box where the scheduling
is updated only after [OK] is clicked.
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ASSIGNING RESOURCES IN A SHEET
If you are familiar with spreadsheets you might
find it easier to assign resources using the Task
Sheet view. It can be a very quick way of
assigning resources and provides a convenient

way of seeing the assignments of more than one
task at a time.

Same File

Try This Yourself:








Continue using the
previous file with this
exercise, or open the file
J407 Assigning
Resources_9.mpp...
If a split line appears
double click on it to
remove it and then
change the view to a
Task Sheet (View >
Other Views > Task
Sheet) with an Entry
table (View > Tables >
Entry)
Move the mouse pointer
to the border between the
Resource Names and
Add New Column
headings and double click
to widen the resource
column
Click in Resource Names
for Clear and level site
and click on the drop
arrow
to see the
resource list

1

2

4

Click on Driver, then
Grader, then Supervisor
and press
Click in the text until the
edit cursor finally appears
and edit the entries as
shown. Press
to
complete the edits

5

For Your Reference…

Handy to Know…

To assign resources in a sheet:
1. Display a Task Sheet with an Entry table
2. Click in the Resource Name cell and click
on the drop arrow
3. Click on all of the required resources and
press

 You can actually type the resource names
into the cell rather than use the drop arrow
and selection method.
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ASSIGNING RESOURCES YOU DO NOT HAVE
While we don’t recommend it, there may be times
when you need to add a new task and assign a
resource that isn’t in the pool. Microsoft Project
allows you to add an unknown resource with a

minimum of information so that you can continue
assigning resources without needing to update the
resource pool.

Same
File

Try This Yourself:







Continue using the previous
file with this exercise, or open
the file J407 Assigning
Resources_10.mpp...

Type Supervisor [50%],
Plumber [200%] and press

Click on the View tab on the
Ribbon and click on
Resource Sheet in the
Resource Views group

There aren't any plumbers or electricians in the resource
list, yet Project has allowed you to enter them without
even a whimper, except for an over-allocation icon at the
left of the task.

4

Type Supervisor [50%],
Electrician [300%] in the
Prepare cabling
infrastructure task and press

An icon appears next to problem resources. This icon
here indicates that some attention is required because
there are more assignments for this resource than
available units.

5

Click in Max for Plumber, type
200% and press
As soon as you press
the
bold red will disappear
because there are enough
resources in the pool to fulfil
the commitment...



3

Click in the Resource Names
cell for Prepare draining
infrastructure

6

Type 300% in Max for
Electrician and press

For Your Reference…

Handy to Know…

To assign resources you don’t have:
1. Type the name of the resource into the
appropriate location
2. Change to a Resource Sheet view
3. Update the units to at least match those
required in the project

 The technique outlined here for adding
resources that aren’t in the pool works for
any of the assignment methods. You simply
type the name of the resource and the
required units – however, you’ll need to
update the resource details at a later time.
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THE CASE STUDY RESOURCES
Resource assignment requires care and attention
to detail and the best way to learn this is through
practise. Our case tasks still require a great deal
more resource assignment. Using whichever of

the assignment methods and techniques you prefer
assign the resources to the remaining tasks as
shown below.

Building Construction
Pour foundations

Rock Solid Concrete

Erect steelwork

Supervisor [50%], Rigger [600%], Boilermaker [600%], Welder [500%],
Labourer [600%], Driver [200%], High Jib Crane, Utility

Erect wall

Supervisor [50%], Carpenter [700%], Labourer [400%], Driver, Grader,
Air Compressor, Electrician [75%], Plumber [25%]

Install roofing superstructure

Supervisor [50%], Rigger [500%], Boilermaker [500%], Welder [300%],
Labourer [500%], Driver [200%], High Jib Crane, Utility, Air
Compressor, Plumber [50%]

Install roof retracting mechanism

Supervisor [50%], Welder, Boilermaker [200%], Rigger [200%],
Electrician [200%], Driver, High Jib Crane

Erect seating tiers

Supervisor [50%], Carpenter [800%], Welder [200%], Boilermaker
[200%], Labourer [500%], Driver, Utility, Air Compressor

Fit Out
Fit all windows and doors

Carpenter [500%], Labourer [200%]

Install electrical cabling

Electrician [300%], Labourer [200%]

Install electrical fittings and
fixtures

Electrician [300%]

Install all plumbing

Plumber [200%], Labourer [200%]

Install plumbing fixtures and
fittings

Plumber [200%]

Lay astro turf

Pure Grass Turf

Erect handrails and fencing

Welder [400%], Boilermaker [200%]

Paint rooms, fixtures, fittings, etc

Painter [500%]

Install PA system

Listen Ear Audio

Install video imaging equipment

In Focus Video

Fit out control room

Electrician [200%], Listen Ear Audio, In Focus Video

Commissioning
Test roof mechanism

Supervisor, Electrician [200%], Rigger

Test PA system

Listen Ear Audio

Test video imaging equipment

In Focus Video

Test control room equipment

Supervisor, Listen Ear Audio [20%], In Focus Video [20%], Architect,
Electrician [200%]

Obtain official occupancy
certificates

Architect, Building Clerk, Supervisor

Obtain safety certification
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NOTES:

1

4
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